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From The GM's Desk 
By Bill Steen, General Manager, KISTERS Pty Ltd 

Another year has flown past as we head towards 2014. Over the last 12 months Kisters has seen multiple 
new local and international clients join the Kisters community. Along with new clients, Kisters undertook a 
variety of client driven projects whilst investing in the continual improvement of the Kisters product suite. 

One of the emerging trends that is gathering momentum around the world is the bringing together of 
geospatial and temporal water information, such as the Texas Hub [http://www.centraltexashub.org/] and 
World Water Online [http://www.worldwateronline.org/]. In 2013 New Zealand added to the global interest 
in interoperability of data via web services. Earlier this year Peter Heweston and Chris Michl represented 
Kisters at a New Zealand forum on interoperability of data, as reported in an earlier newsletter. 

In November 2013 New Zealand hosted a second workshop to discuss progress on interoperability of data. 
I was fortunate to attend and present at this forum. Kisters have made a large impact on New Zealand’s 
push with high praise from users and competitive companies regarding the Kisters Web Interoperability 
Solution (KiWIS). Mark Rodgers from Hilltop mentioned that “KiWIS simply works, you install the product 
and everything just happens”. New Zealand has also made the decision to adopt the Open Geospatial 
Consortium (OGC) standard for hydrological time series encoding. WaterML2. 

The main objective of the KiWIS web service solution is to provide API options via HTTP to be used by 
client programs. Next to KISTERS query services it provides OGC services as well as CUAHSI 
WaterOneFlow or ArcGIS-readable formats - all based on one publishing mechanism and user based 
access. 

There is definitely momentum in the ability to interchange data and Kisters is happy to discuss with you the 
benefits of KiWIS. 

Whilst in New Zealand I attended the New Zealand Hydrological Society and the Meteorological Society of 
New Zealand joint conference in Palmerston North where I was keynote speaker. The theme of the 
conference was “Water and Weather: Solutions for health, wealth and environment”. The underlying 

http://www.centraltexashub.org/
http://www.worldwateronline.org/
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message from both scientific worlds was that of good quality data and the ability to interchange data freely 
between agencies.  

It was an interesting experiment to combine the two sciences, and it proved to be highly successful with 
some extremely interesting, and thought provoking papers. Over 220 people participated from across New 
Zealand including several international guests.  

The Kisters office in Canberra will be unattended on the 27th, 30th and 31st of December. Please contact 
Debbie on 0418 115 925 in case of an emergency during that period. 

As we move closer to 2014, Kisters would like to wish you all a Merry Christmas and a safe and healthy 
New Year. 

 

Bill Steen 

General 
Manager 

KISTERS Pty Ltd   

Water Act November 2013 Amendments 
The Water Act was recently amended, as described below. The main impact on Kisters clients is that 
WDTF will become the mandated format for delivering data to BOM, unless you have other agreements 
with them. If you are still using HYBOMEXP you should plan to move to HYWDTF_OUT soon. See 
http://www.bom.gov.au/water/regulations/amendments/amendments2013.shtml for more detail. 

November 2013 amendment 

The Governor-General made this amendment on 21 November 2013. It takes effect (commences) on 28 
February 2014 

The 2013 amendment allows for the Regulations to specify the format in which water information must be 
given: 

• water information must be given to the Bureau in a form approved by the Director of Meteorology 

• an online Administrative Instrument sets out requirements for organisations to provide water information 
in specified formats eg Water Transfer Data Transfer Format (WDTF) 

• lead water agencies (Category A) and providers of National Groundwater Information System (NGIS) 
and Aquifer Framework information (Category K) are the first groups affected from 28 February 2014 

• over time, the Administrative Instrument will specify formats for additional Person Categories. A planned 
schedule for introducing format requirements for Person Categories and Water Information 
Categories/Subcategories is available. The Bureau will notify affected organisations in advance of 
changes or additions to the requirements set out in the Administrative Instrument. 

Adding new format requirements will depend on the following: 

• the Bureau's need to service products 

• our capacity to ingest and publish the particular data 

• our ability to provide support to affected data providers 

The amendment also adds requirements for the provision of National Groundwater Information System 
(NGIS) information 

New subcategories of water information added in Category 2 (ground water resource information) are: 

• State aquifer framework information (subcategory 2d) 

• State NGIS information (subcategory 2e) 

A new Category of Persons (Category K) is required to give subcategories 2d and 2e to the Bureau. 

This new Category of Persons will be added to the Persons and Classes of Persons document when the 
amendment takes effect on 28 February 2014. The organisations to be included in Category K [14Kb] are 
eight lead water agencies and one water utility. 

http://www.bom.gov.au/water/regulations/amendments/amendments2013.shtml
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2013 KISTERS User Group Meetings 
Canberra 28-29 August, 2013 

The Australian User Group meeting was held on August 28 and 29 at the Hellenic Club in Canberra. The 
meeting was well attended in the end, after everyone battled through budgetary constraints to get there. 
The Hellenic Club proved to be a great venue, and much fun was had by all. 

 

In Session 

 

Emma, Louise, Luisa and Damian 

 

John and Debbie 

 

Radhika, Liping, Denby and Emma 

San Diego 9-10 September, 2013 

Again we convened at the Bahia on beautiful Mission Bay for a couple of days of fruitful exchange. The 
cruise on Mission Bay for the conference dinner is always a highlight, and the weather was delightful as 
usual. 

 

Bill, Ron and Frank 
 

Coffee break 
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Lunch by Mission Bay 

 

The Bahia Belle 

User Group Presentations 

We recorded many of the sessions using Camtasia, and all the recordings and Powerpoint presentations 
from both meetings are available on our web site at http://kisters.com.au/support.html#usergroups - 
contact us for access details if you don’t have them already. 

2014 Meetings 

Start planning for next year's User Group meetings early! The US meeting will be in San Diego on 
September 15 and 16, 2014, and the Australian meeting will be a one-day event in conjunction with the 
Australian Hydrographers Association conference, possibly on Nov 10, 2014 in Sydney though the date 
and location have not yet been confirmed. 

Kisters Australia Forum 
One of the suggestions from the Australian User Group meeting was that we establish a forum to allow 
clients to exchange ideas. That forum is now live, and can be accessed at http://forum.kisters.com.au . It is 
a closed moderated forum and you need to register before you can access it. Please use a real name or 
recognisable email address when registering or we will have to contact you to find out who you are. Only 
registered Hydstra and WISKI client organisations will be granted access to the forum. 

The forum is divided into two top headings, WISKI and Hydstra. As a registered user you can add new 
threads under these headings or contribute to existing threads. 

Please don't use the forum to report bugs or problems, you should continue to use the approved 
mechanisms for that as we make no guarantee as to how frequently the forum will be monitored by Kisters 
staff. Please keep the topics Kisters related, and the tone polite. 

 

http://kisters.com.au/support.html#usergroups
http://forum.kisters.com.au/
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Kisters and Standards 
As usual Kisters has been busy in the standards world. Bill Steen visited Palmerston North, New Zealand 
recently where he took part in a one day workshop on data interchange in New Zealand. 

Peter Heweston has been participating in an interoperability experiment with the Bureau of Meteorology 
and CSIRO which is looking at the exchange of ratings, gaugings and sections in WaterML2. The work is a 
joint development with Water Information Research and Development Alliance (WIRADA) and the Open 
Geospatial Consortium (OGC) Hydrology Domain Working Group. More will be announced when there is 
something concrete to show. 

In another guise Peter Heweston recently attended Meeting 5 of the Water Information Standards 
Business Forum hosted by the Bureau of Meteorology. Amongst the many topics discussed was the 
proposed path for WDTF over the next year or so. 

We have been pushing on with an experimental REST interface for Hydstra, and in conjunction with our 
evolving Standard Hydstra specification we hope that users will be able to publish data from Hydstra in a 
uniform way with meaning as well as formats standardised. 

Both WISKI and Hydstra link to KiWIS, which publishes a number of international standard formats 
including WaterML2. 

Kisters Germany has been involved in developing the SOS 2.0 Profile for the Hydrology Domain Version 
1.1. Kisters and 52 North have been cooperating as part of the GEOWOW project. The project is 
addressing technical vs. semantic interoperability - the problems of transferring meaning rather than simply 
data. 

KISTERS Australia Website 
By Denby Angus 

The Kisters Australia website at http://kisters.com.au has recently acquired lots of new content including: 

Web Publishing 

We have compiled a comprehensive collection of links to sites that use Hydstra\WEB, WISKIWEB or 
custom solutions publishing Hydstra or WISKI data at  http://kisters.com.au/webpublishing.html 

Please inform us of any relevant websites you would like added to the list. 

Support 

The page at http://kisters.com.au/support.html is your central point for links to: 

• Software downloads 

• Phone and Email Support 

• Forum 

• Newsletters 

• User Groups 

Software Downloads 

This page gives you access to previous and current Hydstra releases at 
http://kisters.com.au/downloads.html. 
To download the files you will need a username/password which is supplied by KISTERS support when 
you provide a copy of your HYACCESS licence file. 

The Forum 

Our new forum is a meeting place for sharing and discussing Hydstra and WISKI software. Visit 
http://forum.kisters.com.au/ to view and contribute to the forum. You must register first, and the 
administrator will manually confirm your membership. The forum is NOT for support: please contact us by 
phone (02 61545200) or email (support@kisters.com.au) for all your support requirements. 

Newsletters 

You can view the latest newsletter at  http://kisters.com.au/nl/NL_latest.pdf. We also provide access to 
previous newsletters at  http://kisters.com.au/newsletters.html 

http://www.csiro.au/en/Organisation-Structure/Flagships/Water-for-a-Healthy-Country-Flagship/WIRADA_WFHC_ResearchProfile.aspx
http://www.opengeospatial.org/
http://external.opengis.org/twiki_public/HydrologyDWG/WebHome
http://www.geowow.eu/
http://kisters.com.au/
http://kisters.com.au/webpublishing.html
http://kisters.com.au/support.html
http://kisters.com.au/downloads.html
http://forum.kisters.com.au/
http://kisters.com.au/nl/NL_latest.pdf
http://kisters.com.au/newsletters.html


 

6 

User Groups 

Australian User Group meeting presentations are available at  http://kisters.com.au/user_groups_aus.html, 
while USA User Group presentations are available at http://kisters.com.au/user_groups_usa.html. 

To download the PowerPoint or Camtasia files you will need a username/password which is supplied by 
KISTERS support when you provide a copy of your HYACCESS licence file. 

New Hydstra/WEB features 
By Denby Angus 
We continue to add new features to the Hydstra web portal under projects for Hydstra clients including: 
New South Wales Department of Primary Industries, Office of Water (NOW) - 
http://realtimedata.water.nsw.gov.au/water.stm 

Northern Territory Department of Land Resource Management (DLRM) - 
http://www.lrm.nt.gov.au/water/water-data-portal 

Victorian Department of Environment and Primary Industries (DEPI) - 
http://data.water.vic.gov.au/monitoring.htm 

Data Download Interface 

In addition to existing data access and download facilities, we have added a new multiple site data 
download interface. 

The current working example can be found at the DEPI portal. This is demonstrated by clicking the 
'download sites' link under the Surface Water or Groundwater categories in the left hand side menu frame. 

This interface offers site selection via a site list upload file or spatial selection from the map by radius or 
rectangle. The configuration of data offerings and delivery has been custom built for DEPI and a 
development framework exists to enable us to deliver a bespoke data download package for other Hydstra 
clients if required. 

 

  

OpenLayers / Mapserver 

To enable map navigation (and site selection) for portals with tens or hundreds of thousands of sites, we 
have developed OpenLayers (OL) mapping pages utilising Mapserver. 

These mapping pages are far more scalable than the Google Maps API pages (which we will continue to 
support but not develop further). The OL maps will become the default mapping solution for the Hydstra 
web portal. 

The DEPI portal is the first to use OL maps. The requirement to display over 220,000 sites was beyond the 
capabilities of Google Maps. 

Sites overlays are generated on demand by the Mapserver open source application running on the web 

http://kisters.com.au/user_groups_aus.html
http://kisters.com.au/user_groups_usa.html
http://realtimedata.water.nsw.gov.au/water.stm
http://www.lrm.nt.gov.au/water/water-data-portal
http://data.water.vic.gov.au/monitoring.htm
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server. Its function is managed through the configuration of a set of MAP files and the caching of positional 
information as SHP files. Any other layers may be added to the maps including KML, Google's familiar 
layers and other third party layers. 

New Daily River Report Format with Micro Plots 

Developed for DLRM, this report adds another report type to the options available in the DRR script which 
displays variables trend  micro plots. 

This is demonstrated at the DLRM portal by selecting the Flood Monitoring link and the River Reports tab. 

  

Current values dashboard 

NOW required 'dashboard' maps showing current values for selected sites across the state. They also 
required that one become the new portal landing page. 

This required the development of a regularly scheduled process caching latest values and a map page with 
a dynamic Javascript display. The results are the State Overview river flows page and the Groundwater 
Monitoring Overview page. These pages display summary boxes showing current values and on mouse 
hover they show further details. 
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Grouped Custom Outputs variables 

The Custom Outputs page can now display variables in configured groups (optionally using different 
datasources). The DEPI portal demonstrates this new feature: 

 

  

Hydstra Product News 
Hydstra V11 Release Schedule 

We are coming towards the end of the Hydstra V11 development cycle and we are thinking about starting 
the release process in the first or second quarter of next year. Before we lock the system down we want to 
give you all the opportunity to propose any new database fields and tables, so speak now or forever hold 
your peace. 

There are a number of major new features in V11 that are worth noting, as well as a myriad of smaller 
changes. 

 The most important innovation is a new data discovery wizard that will appear on any Parameter 
Screen program, and will allow even a naïve user to navigate their way through what data is 
available to them 

 The HYDLOG logging framework has been significantly overhauled. All logging is sent to a central 
location in an easily parsed (but less easily read by humans) format. We provide a couple of 
datasources to show interesting information from the log files. 

 We will be able to be more flexible within a version with respect to table changes. We will be able to 
add new tables to the system without updating the version, and we will be able to make minor 
changes in length and type to existing fields if necessary. Unfortunately we won't be able to add 
new fields within a version of Hydstra. 

 SVRMON has been enhanced to monitor both SVRIMP and SVRRUN from another machine. This 
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simplifies starting the SVR programs from a Windows Service and makes the whole process more 
robust. 

 HYRATED and HYRATSHF have been significantly enhanced to interoperate better, and many new 
features have been added following user suggestions. An improved gauging selector has been 
implemented in both programs, and more flexible colour controls offered. 

 We have introduced WIP styles, so you can for example use one set of fonts, spacings and 
background colours for internal publishing, and another for web content. 

 Multi-screen support for HYXPLORE and HYVIEW 
 

If anyone is interested in obtaining a pre-release beta version of Hydstra V11 please contact us and we will 
arrange to give you access - on the strict understanding that you mustn't use it in production yet, and that 
non-upgradeable changes may yet occur. 

Proposed Program Deletions in Hydstra V11 

Does anyone still use any of the following programs? As part of our regular clean-up for a new version we 
would like to remove them if they are obsolete. 

HYDTPRE.EXE   Prepro for DataTaker data 

HYM2000.EXE Unload and Process Mace 2000 Loggers 

HYMIN.EXE Unload and Process a Mindata 3500 Logger 

HYRRDPRE.EXE  Prepro for RRDL data 

HYSIGMA.EXE   Workbench app, Import SigmaData logger data 

NZGAGALL.BAT  Convert all gauging data from Tideda to Text  

NZRATALL.BAT Convert all ratings in a Tideda file to text 

NZTSALL.BAT Convert all TS data in a Tideda file to Hydstra 

NZGAG.BAT Convert one station from Tideda data file to LIST format 

NZRAT.BAT Convert one station's ratings to list format 

NZTS.BAT Convert one station from Tideda data file to LIST format 

NZTAUPO.EXE Convert Taupo logger data to Hydstra 

Please let us know soon if you use these programs. If we remove all specific Mace and Mindata specific 
programs we will delete their associated database tables as well: 

MACECHAN.DBF 

MACEGAUG.DBF 

MACEREG.DBF 

MINLOG.DBF 

MINVAR.DBF 

Actual Program Deletions in Hydstra V11 

We have already removed the following obsolete programs: 

HYBOMEXP Export to BOM in legacy Hydstra XML format 

HYCHECK  Plot Logger Traces for Month 

HYCHECKL Plot LOGPOLL database Check Plots 

HYLOGPLO Plot LOGPOLL Database 

HYMODEL  Produce Data for BOUGHTON or HYDROLOG Modelling Programs 

HYDBBAT  Generate a Batch File from a Database Table 

HYDBTOHY Generate a Hydstra data file from a dBase III+ Database 

HYMACEMC Process MACE Monkey Creek Logger Data 

HYMACE  Read a MACE Data Logger File 

HYMETCLI Create a Hydstra file from Met Bureau Climate Data File 

HYMETDAY Create a Hydstra file from Met Bureau Climate Daily File 

HYMETPLU Create a Hydstra file from Met Bureau Climate Pluvio File 

HYPROADS Process ADS Data to Hydstra File 

HYDMPADS Dump ADS Data to Text File 

HYPROWES Process WESDATA Logger File 

HYRRDUNL Unload a Hydrological Services RRDL-3 Data Logger 

HYRRDPOR Unload a Hydrological Services RRDL3 to Time Series File 

HYSERMAC Service a HYDRO-MACE TRS Logger 

HYWINPIC We use the default picture viewer that comes with Windows) 

HYWINVID We use the default video driver that come with Windows 

NZTIDTS  Import TIDEDA Time-Series Data 

NZTIDRAT Import TIDEDA Ratings 

NZTIDGAG Convert TIDEDA Gaugings to Hydstra 

HYDLLP Enhancements 

Since the release of Hydstra 10.04 there have been numerous additional JSON calls added to HYDLLP. 
The new features are all documented in the Help file, particularly if you download the latest patch. 

get_decoded_value retrieves a field's decoded value if one exists for the provided value. This is handy for 
looking up codes, for example. 

get_effective_rating creates a table that as accurately as possible represents the requested rating table at 
a given point in time. The table is enumerated at a fine interval so you don’t need to worry about P25 or 
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LOG interpolation, and it is interpolated in time so it accounts for phased changes between tables. 

get_site_geojson returns GeoJSON formatted field data from the SITE table for the provided site list. 

get_std_site_geojson provides the same function as get_site_geojson but does it through the Standard 
Hydstra interface. 

get_subvar_details retrieves the functional and descriptive details of a variable and subvar. 

hyfiler_command gives you convenient access to the HYFILER program through the HYDLLP interface. 

write_ts_traces provides a way to write modest amounts of time-series data directly through the HYDLLP 
interface. Large quantities of data should still be handled with HYCREATE. 

Hydstra Patch News 

A new Hydstra patch is released every Friday as a rule, and can be accessed via 
http://kisters.com.au/downloads.htm. You can read the Change Log document to see what patches have 
been made. You will need to contact us for the user login and password. Please include your 
HYACCESS.INI in your request email. 

If you are planning to migrate your instruments system to 10.04 you should pick up a system dated after 1 
Mar 2013 as the instrument migration scripts have had some serious work done on them recently. 

It is worth noting that all web programs are excluded from the patch set, so you can safely patch a system 
without disturbing your Hydstra/WEB site.  

Hydstra 10.04 Current Release 

Hydstra 10.04 was released on August 16, 2012 and now in production in most agencies. The main areas 
of change are a SQL Server version (at a cost), the instruments system and the groundwater system, but 
there are hundreds of enhancements and features that should make 10.04 attractive to everyone. 

We strongly recommend that you copy your production system to a test location, get it running there, and 
then do a trial upgrade. Only when you are happy that your local extensions and enhancements are 
working fine should you go ahead with a production system upgrade. 

If you work closely with other agencies and trade Hydstra data with them you should liaise with them before 
upgrading. Time-series files have not change between 10.03 and 10.04, but every database table has 
changed because they now carry additional auditing fields (DATECREATE, TIMECREATE, 
USERCREATE). 

It is possible with care to downgrade most tables from 10.04 back to 10.03 using HYDBUTIL UPGRADE, 
but if you use instruments or groundwater there have been enough changes that HYDBUTIL UPGRADE 
cannot do the job. 

If you use Hydstra/WEB you will need to liaise with Denby Angus about your 10.04 upgrade as he will need 
to be involved. 

Hydstra V9 Unsupported Soon 

If you are still running Hydstra Version 9 please redouble your efforts to upgrade to V10.04, as V9 will 
become unsupported when V11 is released. It is worth noting that Hydstra V9 will not run under Windows 7 
or Windows 8, nor will it run on 64 bit Windows. 

Mail Your Outputs with Mailto 

In recent patches of V10.04 we provide a handy Perl script mailto.pl which allows you to email any program 
output directly from the parameter screen. You need to have access to an SMTP gateway, and configure in 
it HYMAILER.INI, then you can use mailto.pl: 

When running from a text producing program like HYDAY the command line would be something like: 

hyday hydsys01 a 100.00 140.00 1 1980 1980 end 2400 "mailto.pl(S,peter.heweston@kisters.com.au,Output from 

HYDAY)" 

If the topic has any special characters in it, including commas, surround the subject with single quotes: 

hyday hydsys01 a 100.00 140.00 1 1980 1980 end 2400 "mailto.pl(S,peter.heweston@kisters.com.au,'Output from 

HYDAY, as at 01/12/2001')" 

If you want to send to multiple addresses, quote them with single quotes and join with commas:  

'you@youraddress.com,me@myaddress.com' 

You can of course use all the addressing forms provided by HYMAILER - see the documentation of 
HYMAILER.HSC for details. 

http://kisters.com.au/downloads.htm
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Hydstra and Pi Interoperability 

A number of agencies use Pi from OSISoft as a repository for SCADA and operational data. Over the 
years we have developed a number of ways of interacting between Hydstra and Pi. Although the links tend 
to be organisation-specific, it is worth enumerating the different ways in which Hydstra and Pi can interact: 

1. Hydstra can import data from Pi using the Pi ODBC driver. We use an Excel spreadsheet to 
configure the relationship between Pi tags and Hydstra site, variable and datatrans, and make calls 
to the Pi ODBC driver to retrieve the data. There are some limitations in the amount of data the Pi 
ODBC driver can retrieve in one call, so the interface design needs a little care. 

2. We could develop a Pi datasource for Hydstra, though the limitations on Pi retrievals make it 
messy. 

3. Pi can read Hydstra data using the Hydstra/ODBC. This allows Pi to import computed flows from 
Hydstra for example. This requires a very recently patched version of Hydstra, as we needed to 
implement some more features in our ODBC driver to support the way Pi makes ODBC calls. 

4. One agency has developed a bespoke Pi import script to receive data from HYGENEXP on a 
regular basis, thus keeping Pi synchronised with Hydstra for sites where Hydstra was the primary 
source of the data.  

None of these projects has been entirely standard, so some of the code has not been released as a part of 
Standard Hydstra, and it may require some consulting assistance to get a Pi - Hydstra link going, but 
please contact us if you are interested. 

WISKI Product News 
The main product news for WISKI, KiWQM and KiECO was presented at the yearly user group meeting in 
August this year in Canberra. The major focus was on new functionality and the new server architecture in 
Version 7.3. All presentations and videos from the user meeting can be downloaded from our website. 

A key achievement from the user group meeting (suggested by users) was the establishment of a WISKI 
forum to allow to exchange ideas between clients and moderated by us. That forum is now live, and can be 
accessed at http://forum.kisters.com.au  (see KISTERS Australia Forum). The KiScript Forum 
(http://forum.kiscript.org) launched after the KiScript workshops in Australia in 2012 in Canberra and at 
MHL is already well received and used by our users across the world.   

The release updates of our WISKI/KIWQM clients are proceeding and by the end of 2013 the systems at 
DWR, SEQ Water, Waikato Regional Council and MHL will be running under 7.3. The migration of the 
BOM and Sun Water systems will take place before April 2014 using the 7.4 distribution. Regarding 
functionality, WISKI/KiWQM 7.3 and 7.4 are very similar. It is planned to have all systems updated to 
WISKI 7.4 in 2014. 

The following pages will outline a few key enhancements available in WISKI/KiWQM V7.3 or 7.4. 

Time series representation via Data Sources 

Traditionally WISKI uses a time series concept of calculation rules which are coded in WISKI7 in agents. 
The time series can have saved persistence in the database or stored as virtual time series that are 
calculated on the fly. In addition pre- and post-processing is possible using transformations.  

With the creation of the data source concept, the time series model of WISKI has become more flexible, 
allowing any values with time stamps to be defined as a time series. This allows not only access to internal 
time series data, but also to integrate other internal and external data via a simple standardised interface. 
Time series data sources are configured with a time series data source name and configuration 
parameters that include paths to time series and parameters as well as short names of stations, parameter 
types, etc.  Examples include: Hydstra time series data, water quality sampling results, dated station 
metadata. The data sources can be combined with transformations such as max, min, mean etc. 

Data Sources for water quality sampling results 

Data Sources provide an alternative option to creating KiTSM time series with the sample results agent. 

http://forum.kisters.com.au/
http://forum.kiscript.org/
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Configuration of a Water Quality Data Source : 
WQSampleValues(all,[site/station short name],<parameter Type shortname>,<method 

shortname>,original|production) 

 
Can be used in combination with transformations e.g.: 
WQSampleValues(Production);Mean(year) 
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Data Sources for Hydstra time series 

Create a file called tsdatasource-hydstra.properties with the following connection information: 
user=<user> 

pw=<password> 

accesspath=<Hydstra access path> 

configurationpath=<Hydstra configuration path> 

Place file in the <jproc.config.dir> directory 
Add the location of the Hydstra run path to the system path on the client PC 
Open the WISKI Client. Goto System View > Operations > Tools > Show Data Source 
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Station, Parameters and Time Series Templates 

Existing Stations, Parameter and Time Series can now be saved as templates in the database. Variables 
can be set up for any part of the template that will change when being applied e.g. Export number. The 
user will then be prompted for these variables in the template wizard. 

 

 

Management of existing templates is done through an intuitive user interface (shown below)  

 

Time Series Versioning 

It is now possible to store a history of changes to time series. This can be activated during creation of the 
time series by selecting Storage Configuration: Persistent – Database (Compressed with Data history). All 
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changes are then recorded automatically and you may search and browse for previous versions. 

 

You may then plot and overlay different time series versions for comparison and check the state of data at 
any point in time. 

New Features in KiWQM  

The take up of the Kisters Water Quality Module within Australian and overseas markets continued to gain 
momentum in 2013 which has in turn has driven the development of many new features. Along with the 
consolidation of the base features, the year has seen an emphasis on developing more targeted data 
importing, data review and validation, analysis and export tools. Some of these new features are outlined 
below. 

CSV Importer 

Existing csv import configurations can now be saved as a new configuration to save time when creating 
new configurations. The configurations can be saved within groups allowing for better organisation and 
management for larger organisations. Rows and individual cells can now be mapped as well as columns 
(see example below). 

 

An improved wizard dialog allows grouped column identification for an easy mapping of csv file columns 

(see below). 
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Also a simplified csv import option is available where a WQ import configuration can be set up and then 

certain users can be given access to that configuration only within a cut down import interface to reduce 

complexity. The simplified csv importer is available over an explorer view for an improved workflow and 

easy user access. 

Extended Data Validation  

In addition to the standard data validation of water quality data during csv import (e.g. correct data types, 
compulsory fields etc.) a new feature exists that gives a more detailed analysis of what the import will do – 
especially when updating existing data and what subsequent actions to take. The analysis will show 
whether importing the data would: 

 Creating a new sample – with the first value of a result 

 Updating a sample – with the first value of a result 

 Updating a sample – updating the result 

 Updating a sample – deleting a result 

 Updating a sample – result identical 

 

The feature then allows you to set a rule to either accept or reject the import of data dependent on each of 
these scenarios. In addition each individual record can be accepted or rejected. This gives better data 
protection and data integrity. 
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Plausibility Checks 

These data validation checks are designed to form part of an organisation's quality assurance and quality 
control process.  They allow the user to select from a variety of data analysis procedures, which can be 
configured within the system settings, to assist with making assessments as to the veracity of any given 
set of WQ data. Available plausibility checks include: 

 Extreme Value – check if the sample result is between the maximum and minimum values that 

were recorded within a specified time range for that parameter 

 First Value – check if the sample result is the first record value for that parameter 

 Method Quantification Limits – check if the sample result is higher or lower than the analysis 

method’s quantification limits 

 Percentiles (VDI, Excel, Hazen etc) – check if the sample result is between the minimum and the 

maximum percentile, using the defined system settings 

 Comparison List – checks if the sample result is within a given comparison list 

Based on the results of these analyses, actions can be defined such as setting quality codes or comments 

on the data. 

 

 
 

Calculation Methods 

It is now possible for the analysis method of a parameter to be set to a linear transformation from a source 
parameter with a factor and an offset. Examples include – nitrogen conversion, conductivity conversion, 
dissolved oxygen saturation etc. 
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Raw Data Export 

A new export has been introduced to provide another quick and easy method to export water quality results 
in csv or txt format using a wizard interface. Access this export via the File > Export > WQM menu and 
uses a number of simple pick boxes and the standard WQM filter. 

 

Optimisation and Efficiency for Water and Mining 
By Massimo Antinarelli 

The Kisters solution offering has always been focussed on powerful water and energy management 
solutions. During 2013 the Kisters platform has proven its interoperability with a variety of successful 
worldwide implementations dealing with the integration of cross-linked water and energy systems. We have 
selected three project highlights with different application environment, worldwide locations and business 
objectives: 

VALE (Brazil)  

Vale, the second-largest mining company in the world, has chosen the Kisters’ ResOpt solution for the 
optimal planning of the water cycle management in 13 mining sites. The primary objective of this project is 
the combination of the technical, environmental and regulatory constraints whilst providing the most cost-
effective water planning in a complex environment. The modelling encompassed the best water flow 
scheduling for dams, pumps, complex demands, factories, sumps, water treatments, rivers, reservoirs, 
hydrants, water trucks and industrial and human consumption. The solution has been integrated with a GIS 
for internal and public visualization.  
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TransAlta (Canada) 

TransAlta is the largest power generator in Alberta with over 8,000 MW of net capacity. The primary 
objective of this project is profit maximisation for 800 MW of hydropower capacity consisting of two water 
systems with a total 11 storage and run-of-river power units. The main challenge was combining the water 
environmental constraints, electricity market complexity, and energy demand with flood management. The 
project has been successfully completed and won an award at the HydroVision International conference 
(Nashville, July 2013). The business process is represented in the figure. 

 

Ayesa (Spain) 

Ayesa is a global consultancy company implementing management system worldwide with its 2,800 
employees workforce. The project objective is the delivery of a decision support system for the water 
supply systems of the Commonwealth of Taibilla Channels (MCT) in south east Spain. The water systems 
encompasses the water-flow planning for 3 main channels, 3 desalination plants, 1 water treatment plant, 
16 pumping stations, 39 water storages and 16 regulation gauges. The main challenge was modelling of 
delay time among system components and of pressure levels in pipes and storages. 

Kisters On the Web 
Kisters technology is at the heart of an increasing number of customer web sites, whether they be based 
on Hydstra or WISKI web technology or their own web developers. You can visit a selection of client web 
sites via the link page at http://kisters.com.au/webpublishing.html. 
If your web site uses Kisters software please contact us with the URL and we’ll add it to the list. 

Worldwide KISTERS News 
You can keep up to date with all the news from KISTERS worldwide through the following links: 

http://www.kistersnews.com/au/index.html 

http://www.kisters.net/news.html 

WMO Publications Online 
The World Meteorological Organisation (WMO) publishes a valuable library of free publications relating to 
data collection standards. You can see the collection at: 
http://library.wmo.int/opac/index.php?lvl=etagere_see&id=39 .  

Of particular relevance to the water industry are: 

Guide to Hydrological Practices, Volume I : Hydrology – From Measurement to Hydrological Information 

http://kisters.com.au/webpublishing.html
http://www.kistersnews.com/au/index.html
http://www.kisters.net/news.html
http://library.wmo.int/opac/index.php?lvl=etagere_see&id=39
http://library.wmo.int/opac/index.php?lvl=notice_display&id=542
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Guide to Hydrological Practices, Volume II : Management of Water Resources and Applications of 

Hydrological Practices 

Guidelines for the education and training of personnel in meteorology and operational hydrology - Vol.1 

Meteorology 

Guidelines for the education and training of personnel in meteorology and operational hydrology - 

Volume II: Hydrology 

Manual on Stream Gauging, Vol. I: Fieldwork 

Manual on Stream Gauging, Vol. II: Computation of discharge 

Manual on estimation of Probable Maximum Precipitation (PMP) 

Load them up on your Kindle or iPad and you'll have reading for a month! 

Training Courses 
We are happy to provide training courses on any aspect of Hydstra provided there are sufficient people 
interested in attending. Please contact us at support@kisters.com.au with expressions of interest for any 
training requirements you have. We can provide training at your office or here in Canberra. Training in 
Canberra is based on a per-person per-day cost, provided we have sufficient people attending. Training at 
your office will be charged at our standard consulting rates per day for the trainer, plus a preparation day, 
plus travel and accommodation at cost. Courses we can offer include: 

•      Basic Hydstra 

•      Advanced Hydstra 

•      Administering Hydstra 

•      Administering Hydstra/WEB 

•      Hydstra Modelling with MODSYN 

•      Hydstra/SVR Server 

•      Ratings and Gaugings 

•      HYWDTF_OUT 

•      Using Perl with Hydstra 

Please contact us via support@kisters.com.au if you wish to attend. We will register you interest and notify 
you when the next course is planned. 

Staff News 
PRINCE2 Project Management 

Damian Skinner recently completed a week of training in the PRINCE2 project management methodology. 
He is now a Registered PRINCE2 Practitioner, which sounds very impressive! His opinion of the course is 
that it was worthwhile in terms of understanding how major agencies manage large projects, but possibly a 
tad overblown for many of the smaller projects we are often involved with.   

 

Damian Skinner 

 

 

http://library.wmo.int/opac/index.php?lvl=notice_display&id=543
http://library.wmo.int/opac/index.php?lvl=notice_display&id=543
http://library.wmo.int/opac/index.php?lvl=notice_display&id=176
http://library.wmo.int/opac/index.php?lvl=notice_display&id=176
http://library.wmo.int/opac/index.php?lvl=notice_display&id=6760
http://library.wmo.int/opac/index.php?lvl=notice_display&id=6760
http://library.wmo.int/opac/index.php?lvl=notice_display&id=540
http://library.wmo.int/opac/index.php?lvl=notice_display&id=538
http://library.wmo.int/opac/index.php?lvl=notice_display&id=1302
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Hockey Misfortune 

No, not the Treasurer, but Vicky Isaac from our Hobart office had the misfortune to damage her leg badly 
in a hockey accident, resulting in a very nasty fracture which has had her laid up at home for months, with 
some months on crutches still to go. We wish her a full recovery - eventually! 

 

Vicky Isaac 

Work Experience Students from Germany 

We recently hosted two work experience students from Germany for a few weeks in November and 
December. Danilo Rahe and Malte Visse have completed their high school education and are spending a 
year travelling in Australia before knuckling down to further study. While they were with us they carried out 
such useful tasks as data cleansing with Excel, and office cleansing with plastic bags. The boys were 
excellent and enthusiastic workers, and we wish them well for the rest of their travels in Australia and their 
subsequent careers. 

 

Malte Visse 

 

Danilo Rahe 

Kisters Staff Christmas Party 

On Dec 12 we gathered at the German Club (how appropriate) for a festive meal that included pork 
knuckles and plenty of fine German beer. The usual array of tasteful presents (limit $5) provided much 
merriment after dinner. 

 

Santa Bruce 

 

Going in for the kill 
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Who stole the cookies? 

 

Rudolph and friend 
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